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WHAT IS THE INTERNET? 
 
The Internet is a super network of networks that links computers to 
computers sharing a common addressing method and a vast amount of 
information.  The computer networks are linked to one another globally and 
can communicate very quickly.  By just typing a web address, a person can 
contact someone in London, England within seconds. 
 
No one is certain just how large the Internet is because new sites are 
constantly being added around the world.  The sheer size of the Internet is 
currently estimated to contain over trillions of documents.   
 
COMMON WAYS TO USE THE INTERNET 
 
• Communicate via E-mail world-wide. 
• Research information, read book reviews, locate legislative bills, and 

find other information. 
• Use a Search Engine to find Internet sites on news, a subject, or 

product. 
 
GETTING CONNECTED TO THE INTERNET 
 
To access the Internet via a computer, you need a modem, a computer, a  
telecommunications link, and software to dial an Internet Service Provider  
(ISP).   There are several Internet Service Providers (ISP) available, such as:  
America Online; JUNO; AT&T; NetZERO; Earthlink; Microsoft Network;  
and many other ISPs. 
 
A faster way to access information on the Internet is to use a DSL (Digital  
Subscriber Line).  This method costs more to dial up but is able to upload and  
download information much faster than a standard dial up ISP. 
 
INTERNET SERVICE PROVIDERS: 
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Internet Service Providers (ISP) charge a monthly fee to the consumer for  
using the Internet.  The ISP’s have a local number to dial so the telephone  
costs are minimal.  You must have a modem and communication software  
(ISP software) to use the Internet. 
 
Before you sign up with an ISP, it may be a good idea to request a  
demonstration disk in order to compare the differences between the various 
ISP’s.  The demonstration disks often offer a trial period of about 30 days. 
 
Some ISP’s have a flat fee for the number or hours used and may charge  
extra beyond those hours.  Most ISP’s send the consumer a weekly or  
monthly update on new web sites via E-mail and may provide a printed or  
online monthly newsletter or magazine. 
 
DSL: 
 
A DSL (Digital Subscriber Line) uses standard telephone lines.  DSL is a 
constant connection that is a direct feed from the Internet to your computer, 
24 hours a day, 7 days a week.  Some of the more popular DSL providers are: 
Verizon; Pacific Bell; Earthlink; MSN; and Sprint.  The cost of DSL 
providers may vary according to bandwidth or speed.   
                 
WORLD WIDE WEB 
 
The World Wide Web makes up the largest percentage of the Internet.  Key 
words are searched through various search engines. Some of the most popular 
search engines are: Yahoo; Lycos; and Google. 
 
In addition, there are meta search engines that find matches in several search 
engines at once.  Some popular meta search engines are: SurfWax; Vivisimo; 
Ixquick; MetaCrawler; and others. 
 
INTERNET ADDRESS 
 
There are four main parts to the Internet web address:  



 
 

3

(1) the user name of the Internet address (http://www.)  
(2) location (brailleinstitute) 
(3) the trailing domain (org)   
(4) the country (au for Australia) 
 
This is an example of a web address:  
http://www.brailleinstitute.org 
 
New trailing domains are being added all the time.  The most common 
trailing domains are: 
 
Organizational suffixes: 
 
com  A company or a commercial institution (Example: arrow.com) 
 
edu  An educational institution (Example: mit.edu) 
 
gov   government site (Example: nasa.gov) 
 
int  An International organization 
 
mil  A military site (Example: af.mil) 
 
net  Gateways and other administrative hosts (Example:  
  earthlink.net) 
 
org  Private organizations (Example: brailleinstitute.org) 
 
tv  Television networks (Example:  nbc4.tv) 
 
Country codes:  (Example: http://www.rnib.org.uk)   
(uk = United Kingdom) 
 
at  Austria 
 



 
 

4

au  Australia 
 
be  Belgium 
 
br  Brazil 
 
ca  Canada 
 
de  Germany 
 
dk  Denmark 
 
fr  France 
 
hk  Hong Kong 
 
in  India 
 
it  Italy 
 
jp  Japan 
 
nz  New Zealand 
 
ru  Russian Federation 
 
uk  The United Kingdom 
 
us  United States 
 
SEARCHING FOR PEOPLE, ADDRESSES AND PHONE NUMBERS 
 
Most search engines have the capability of searching for businesses and 
persons and lists addresses and phone numbers.  You can also find phone 
numbers by using the White Pages or Yellow Pages on the Internet.  You can 
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locate personal names by searching the White Pages 
(http://www.whitepages.com).  You can find business categories or business 
names by searching the Yellow Pages (http://www.yellowpages.com).  These 
web sites are fairly easy to use to locate individuals or businesses.   
 
ACTIVATING LINKS 
 
A link moves the Internet user from one page on the Internet to another page. 
The link can be text or a picture and is usually underlined and/or a different 
color than the other text.   
 
For large print users:  When you can place your pointer on the underlined 
and/or highlighted text or a picture, the arrow changes to a pointing hand 
which indicates it is a link.  You can activate a link when you click the left 
mouse button.  When the link is activated, the hand icon changes to a symbol 
that indicates that the web page is loading.  When the loading is finished, the 
symbol disappears. 
 
For JAWS users:  When you press the arrow down, you can hear “Link” 
and the name of the link.  If you wish to go to the link, you can press 
ENTER.  You can also list the links by going to the top of page by pressing 
CTRL+HOME.  You can press INSERT+F7 to list the links and move the 
arrow down to a link and press ENTER. 
 
WEB BROWSERS 
 
Web browsers are programs, which navigate the Internet, access worldwide 
sites, and locate data.  Browsers also assist in organizing frequently visited 
sites into files.  The two most commonly used Web browsers are Netscape 
Navigator and Microsoft Internet Explorer.  The patron computer uses 
Microsoft Internet Explorer.  It is a good idea to update your web browser 
every six months when newer versions are added.   
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MICROSOFT INTERNET EXPLORER INSTRUCTIONS 
 
Microsoft Internet Explorer comes with Windows ‘95, Windows ‘97, 
Windows ‘98, Windows 2000, and Windows XP.  It is one of the most 
popular Web browsers available on the Internet and has similar features as 
Netscape Navigator, which is another web browser.   
 

1. Title bar - The Title Bar is at the top line of Microsoft Internet 
Explorer.  It displays the name of Microsoft Internet Explorer.  On the 
right side of the Title bar are three buttons: minimize, restore or close.  
The minimize button appears as a box with a dash in it.  The restore 
button appears as a box within a box.  The close button appears as a 
box with an X in it. 

 
2. Menu bar - The Menu Bar is the second line of Internet Explorer.  It 

displays the current menus: File, Edit, View, Favorites, Tools, and 
Help. 

 
3. Address (URL line) - The Internet Address bar is the third line of 

Internet Explorer.  It displays the current Web address.  You can type a 
new Web address here and go to a new Web site.   

 
(For JAWS users:  To move your cursor to the Internet Address bar, 
press CTRL+O, type the Internet Address, and press ENTER.) 

 
4. Toolbar - The Toolbar is the fourth line of Internet Explorer.  The 

Toolbar displays icons (pictorial images) for frequently used 
commands, such as: Back (left arrow symbol), Forward (right arrow 
symbol), Stop (a symbol with a red X within a box), Refresh (alternate 
directions symbol), Home (house symbol), Search (magnifying glass 
symbol), Favorites (star symbol), and Print (printer symbol).  

 
5. Status Bar - The Status Bar is located on the bottom of the Internet 

Explorer screen.  The bar displays action on the page.  On the far left 
side of the bar is the “START” button and on the far right side of the 
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bar is the time.  Between the “START” button and time, the programs 
that are open are displayed on the bar. 

 
6. Scroll Bars - Vertical scroll bars are on the right side of Internet 

Explorer and the horizontal scroll bars are on the second line from the 
bottom of the Internet Explorer screen.  Horizontal and vertical scroll 
arrows are used to view applications.   

 
USING HELP ON INTERNET EXPLORER 
 
You can use the Help Topics on the Help Menu if you need assistance.   
 
For large print users:  Click on the Help key on the Menu Bar to access the 
Help Menu options. 
 
For JAWS users:  Press ALT+H to go to the Help key on the Menu Bar to 
access the Help Menu options. 
 
EXITING INTERNET EXPLORER 
 
Press ALT+F4 to exit Internet Explorer. 
 
BASIC INFORMATION ABOUT INTERNET EXPLORER: 
 
The “Back” button and “Forward” button are pictorial icons used to move the 
Internet user backward one screen or forward one screen.   
 
For large print users:  If you want to go back a screen, click the “Back” 
button and if you want to go forward click the “Forward” button.  To return 
to the home page, click the “Home” icon of a house. 
 
For JAWS users:  If you want to go “Back” a screen, press ALT+LEFT 
ARROW and press ALT+RIGHT ARROW to go “Forward” a screen.  To 
return to the home page, press CTRL+HOME.   
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Refresh or Reload 
 
You can “Refresh” or “Reload” by pressing the F5 key.  “Refresh” is another 
feature that accesses the freshest version of the document available and 
prevents you from going to an older cached version.  
 
Find or Search 
 
You can also use the “Find” or “Search” button to find a specific string.  
Using Find, press CTRL+F and type the search string.  Then, press ENTER 
to search for terms.  You can repeat this throughout the web site.  To cancel 
“Find” dialog box, just press ESCAPE. 
 
Error Messages 
 
If there are error messages or if the program crashes, the computer will 
freeze.  It is best to turn off the power on the computer and wait about 30 
seconds before getting back onto the Internet.  Another problem you may 
face is that a web address may no longer exist because the webmaster may 
have moved the website to another web address or may have eliminated the 
web address.   
 
Another problem that a person may face on the Internet are “Pop Up” 
windows.  “Pop Up” windows are usually advertisements for products.   
 
For large print users:  To close Pop up windows, click on the “Close” 
button. 
 
For JAWS users:  To close Pop up windows, press ALT+F4. 
 
EXERCISE #1 - BEGINNING INTERNET EXPLORER: 
 
1. Start your Internet Service Provider.  Internet Explorer and your home 

page appear on the screen. 
2. Review the menu options. 
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For large print users:  Click on each Menu Bar item to view the menu 
options.  A pull down menu will appear each time you click a menu option.   
 
For JAWS users:  Press the ALT key to go to the Menu Bar.  Move the 
arrow to the right until you hear a menu option, press the down arrow key 
until you find an option, and press ENTER. 

 
3. Review all the menu options. 
4. Press ESCAPE twice to return to the web browser. 
5. Press ALT+F4 to exit Internet Explorer and return to the desktop. 
 
NOTE:  Another way to access the Menu options is to press a combination of  
keys.  ALT+F will go to the File Menu, ALT+E will access the Edit Menu,  
ALT+V will access the View Menu, ALT+A will access Favorites, ALT+T  
will go to Tool Menu, and ALT+H will go to the Help Menu. 
 
EXERCISE #2 - OPENING A WEB SITE ON INTERNET EXPLORER: 
 
1. Log on to your Internet Service Provider. 
2. Internet Explorer and your home page will appear on the screen. 
3. Click on the Internet Address bar or press CTRL+O. 
4. Type the address: http://www.nasa.gov 
5. Press ENTER.  You are now at the NASA Home Page. 
6. Exit Internet Explorer by pressing ALT+F4. 
 
EXERCISE #3 - USING FAVORITES ON INTERNET EXPLORER: 
 
“Favorites” on Internet Explorer is similar to “Bookmarks” on Netscape 
Navigator.  “Favorites” lets you to go to frequently visited Web sites very 
quickly.  It is impossible to remember all the web site addresses that you 
want to return to, and Favorites helps you find and organize these addresses 
quickly. 
 
1. Log on to your Internet Service Provider.  Internet Explorer and your 
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home page will appear on the screen. 
2. Click on the Internet Address bar or press CTRL+O. 
3. Type the address:  http://www.aph.org 
4. Press ENTER. 
5. Click “Favorites” on the Menu Bar or press ALT+A.   
6. Click “Add to Favorites” or arrow down to “Add to Favorites” and 

press ENTER. 
7. The web site has been saved on to “Favorites.” 
8. Click OK or press TAB to OK and press ENTER. 
9. Press ALT+F4 to exit Internet Explorer. 
 
EXERCISE #4 - CREATING AND ORGANIZING FAVORITES 
FOLDERS: 
 
Folders are like manila folders where you put related information under a title 
such as “Contracts.”  Folders are an easy way to organize web site addresses 
and locate web site addresses.  You can have folders for “Letters,” “Memos,” 
“Legal Information,” and so on.  You can also create subfolders such as 
“Personal” or “Business” under the main folder of “Letters.” 
 
For large print users: 

 
1. Log on to the Internet Service Provider.  Internet Explorer and your 

home page appear on the screen. 
2. Click “Favorites.” 
3. Click on “Organize Favorites.” 
4. You are at a folder dialog box.  Click on the “Create Folder” button. 
5. The cursor moves to “New Folder.”  
 Type:  Blind Organizations 
6. Press ENTER. 
7. Click “Close” to exit the dialog box.  A new folder has been created. 

 
For JAWS users: 
 

1. Log on to the Internet Service Provider.  Internet Explorer and your 
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home page appear on the screen. 
2. Press ALT+A for “Favorites.” 
3. Arrow down to “Organize Favorites” and press ENTER. 
4. You are at a folder dialog box.  TAB to the “Create Folder” button 

and press ENTER. 
5. The cursor moves to “New Folder.”   Type:  Blind Organizations 
6. Press ENTER. 
7. Press ALT+F4 to “Close” or exit the dialog box.  A new folder has 

been created. 
 
EXERCISE #5 - ORGANIZING FAVORITES FOLDERS: 
 
In this exercise, you will save a web site in the Favorites folder “Blind 
Organizations.” 
 
For large print users: 
 

1. You are still in Internet Explorer. 
2. Click on the Internet Address bar.  (NOTE:  You don’t have to type 

http://www each time.) 
3. Type:  afb.org 
4. Press ENTER. 
5. Click on “Favorites.” 
6. Click “Add to Favorites.” 
7. Click the “Create in” button. 
8. Arrow down until you reach “Blind Organizations” and press 

ENTER.  The AFB (American Foundation for the Blind) web site 
address is now saved under the “Blind Organizations” folder. 

9. Click the “Back” button to return to the previous web page. 
10. Click the Favorites Menu. 
11. Click the “Blind Organizations” folder. 
12. Click “American Foundation for the Blind.” 
13. Press ALT+F4 to exit Internet Explorer and return to the desktop. 
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For JAWS users: 
 

1. You are still in Internet Explorer. 
2. Press CTRL+O to open the Internet Address bar.  (NOTE:  You 

don’t have to type http://www each time.) 
3. Type:  afb.org 
4. Press ENTER. 
5. Press ALT+A to go to “Favorites.” 
6. Arrow down to “Add to Favorites” and press ENTER. 
7. Press the TAB to the “Create in” button. 
8. Press the arrow down until you reach “Blind Organizations” and 

press ENTER.  The AFB (American Foundation for the Blind) web 
site address is now saved under the “Blind Organizations” folder. 

9. Press ALT+LEFT ARROW to return to the previous web page. 
10. Press ALT+A for the “Favorites” menu. 
11. Arrow down to the “Blind Organizations” folder. 
12. Press the right arrow and move the arrow down to  “American 

Foundation for the Blind.” 
13. Press ENTER.  The cursor will go to the “American Foundation for 

the Blind” web site. 
14. Press ALT+F4 to exit Internet Explorer and return to the desktop. 

 
E-MAIL 
 
E-mail stands for electronic message sent by a sender to a recipient or 
multiple recipients.  One of the biggest advantages of using E-mail is the 
ability to type a document in Microsoft Word, attach it to the E-mail, and 
send it to someone in Miami, Florida within seconds.  E-mail is 
instantaneous, regular mail is now termed “Snail mail.”   
 
You can set up a free E-mail account on the patron computer on Yahoo and 
other web sites.  If you have further questions on how to use E-mail on the 
patron computer, please contact the front counter person, at extension 3160, 
who will contact the Information Technology Department for assistance. 
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SEARCH ENGINES 
 
Now, that you know a little about the history of the Internet, some of the 
terms, how to use Web browser, and what it can do for the Internet user, you 
can begin searching for information on search engines. 
Search engines do keyword searches against a database.  The most popular 
search engines are: Google, Yahoo, Excite, HotBot, Lycos, and Teoma. 
Yahoo is a good search engines for subjects that are a needle in a haystack.   
 
For more in-depth, multi-threaded or meta search engines, you can use 
Vivisimo and MetaCrawler, in addition to other multi-threaded search 
engines. 
 
OVERVIEW OF SEARCH ENGINES: 
 
When you want to search for information on the search engines, go to the 
search box and type keywords, terms or names on the search engines and 
press ENTER.  Sometimes, you have time press TAB and ENTER after the 
search terms to start the search. 
  
Google (http://www.google.com) 
Google is one of the most comprehensive search engines available.  It 
searches for keywords and does some advanced searching.  Google can find 
search terms or keywords very quickly and accurately. 
 
Yahoo (http://www.yahoo.com) 
Yahoo is one of the most popular and comprehensive subject search engines 
to use. Yahoo gives alternative ways to refine the search.  In addition, Yahoo 
has access to hourly news, weather, sports, entertainment, and stock reports. 
 
Teoma (http://www.teoma.com) 
Teoma debuted in Spring 2001 and was relaunched in April 2002.  Teoma 
has expanded and improved search features.  Phrase searching refers to using 
“double quotes” around a phrase.  Search terms are not case sensitive and can 



 
 

14

be entered in uppercase, lowercase or mixed case.  Teoma ignores stop words 
such as “the,” “of,” “and,” and “or.” 
 
Excite (http://www.excite.com) 
Excite contains 55 URLs and also indexes Usenet news.  Excite an in-depth 
subject arrangement of 150,000 sources.  Also, Excite offers Channels; 
sports, weather, news, people finder, chat, horoscopes, travel, maps, 
computer, shopping, lifestyles, games and automobiles.  It uses plus to 
include or the minus key to eliminate a condition.   
 
HotBot (http://www.hotbot.com) 
HotBot indexes over 100 million sites and is easy-to-use.  Also, it has subject 
directories, discussion groups, search for businesses, people and E-mail 
addresses, classifieds, stocks and shareware.   
 
Lycos (http://www.lycos.com) 
Lycos is one of the oldest search engines but keeps up with new, relevant 
sites.  Lycos offers a simple and an advanced search called Lycos Pro.  It 
includes Web guides to computers, careers, government, health, women, 
money and many other popular subjects.  
  
META SEARCH ENGINES: 
 
Meta search engines are powerful search engines that search for keywords in 
more than one search engine simultaneously.  Some search engines eliminate 
duplicate findings.  Using meta search engines, you can find the closest 
matches to your search string.   
 
Meta search engines are very useful because:  (1) they do powerful searching 
for keywords; (2) most good meta search engines accept complex searches; 
and (3) meta search engines search many search engines simultaneously. 
 
In many of the meta search engines, you do not have to open the search box 
because the cursor may automatically appear there.  You can just type the 
search string and TAB to the “Search” button and press ENTER. 
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Some of the most well known meta search engines are: 
 
MetaCrawler (http://www.metacrawler.com) 
MetaCrawler is an excellent multi-threaded web search.  It sends queries to 
several Web search engines such as Google, Findwhat, Teoma, Overture, and 
Inktomi all at once.  
 
Metaeureka  (http://www.metaeureka.com) 
This meta search engine gives results of search engines such as HotBot,  
Dmoz, AlltheWeb, FindWhat, Gigablast, Teoma, and Yahoo.  It sorts 
findings by relevancy and removes most of the duplicates. 
 
Dogpile (http://www.dogpile.com) 
This meta search engine does simultaneous searches of subject directories.  
You can also customize the search order with some advanced search 
operators.  Dogpile searches through search engines such as:  Google, Yahoo, 
About, LookSmart, Overture, Teoma, FindWhat, and others. 
 
SurfWax (http://www.surfwax.com) 
This meta search engine queries multiple Internet search engines 
simultaneously, such as AllTheWeb, AOL, Excite, Google, Hotbot, MSN, 
Yahoo, and other search engines.  It provides good documentation. 
 
Vivisimo (http://www.vivisimo.com) 
This meta search engine queries multiple Internet search engines 
simultaneously, such as Google, AllTheWeb, Lycos, MSN, and others.   
 
Ixquick (http://www.ixquick.com) 
This meta search engine queries multiple Internet search engines 
simultaneously, such as AOL, Hotbot, Google, AllTheWeb, Lycos, MSN, 
and others.  Includes subdivisions in search results. 
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HOW DO I SEARCH FOR INFORMATION 
ON THE INTERNET? 

 
When you search for information on the Internet, you want to use basic 
search terms or basic keywords.  You don’t want to type a sentence or a 
paragraph.  You want to use the most basic search terms to find accurate 
information on the web sites as quickly as possible. 
 
Search Box: 
 
You can type search terms or keywords in the “Search Box” of a search 
engine.  The Internet is updated constantly and you may not get the same 
results all the time.   
 
For large print users:  Click on the “Search Box.”  Type the search terms 
and press ENTER or click on the “Submit,” “Go” or similar button. 
 
For JAWS users:  There are two ways you can go to the “Search Box.”  The 
easiest way is to press the CTRL key at the same time you are pressing the 
INSERT+7 keys on the numeric keypad.  When you hear “Edit,” press 
ENTER and you will hear “Forms Mode On.”  The second way to get to the 
“Search Box” is to press CTRL+HOME to get to the top of the page.  Press 
the arrow down until you hear “Edit,” press ENTER, and you will hear 
“Forms Mode On.”  Once you type the terms, you can press ENTER or press 
TAB until you reach the “Submit,” “Go” or similar button and press ENTER. 
 
Here are some examples of general searches: 
 
If you would like to find information on the history of Kuwait, you could 
type: 

history of Kuwait 
 or 
Kuwait history 
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If you would like to find the current weather conditions in Chicago, Illinois, 
you could type: 

Chicago Illinois weather 
 or 
weather Chicago Illinois 
 

If you would like to find a recipe for baked fish, you could type: 
baked fish recipe 
 or 
recipe baked fish 

 
If you are looking for information with a specific name, title, company name, 
or other specific information, you can type the search terms in quotations as 
follows: 
 
For President John F. Kennedy, you would type: 

 
“John F. Kennedy” 
 or 
“President John F. Kennedy” 
 

For IBM Corporation, you would type: 
 
“IBM” 
 or 
“IBM Corporation” 

 
For the Los Angeles Lakers basketball team, you would type: 

 
“Los Angeles Lakers” 
 or 
“LA Lakers” 
 

 
 



 
 

18

For information on the life of Elvis Presley, would type: 
 
“Elvis Presley” biography 
 or 
life of “Elvis Presley”  
 

Here are some examples of complex searches: 
 

Complex searches require more exact search terms than basic terms.  You can 
combine several basic terms. 
 
You may wish to find the population of Miami, Florida from 1990 to 2000.  
There are many ways you can approach this search.  You can type: 

 
Miami Florida population 1990 to 2000 
  or 
Miami Florida population 

 
You may wish to find about the earliest settlers in Boston, Massachusetts.  
You can type: 

 
Boston Massachusetts early settlers 
  or 
early settlers Boston 

 
You may wish to find information on retinitis pigmentosa.  You can type: 

 
retinitis pigmentosa 
 or 
Retinitis Pigmentosa (RP) 

 
There are many ways to find similar information on the Internet.  Just try 
different combinations of keywords and search words to find the best results. 
The more practice you have on the Internet, the more accurate the searches.
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GLOSSARY 
 
There are several terms that are used on the Internet such as: 
 
Bandwidth  The capacity of a medium to send and receive a signal. 
 
Baud Rate  The rate of data transfer referring to modem speed. 
 
BBS   Bulletin Board Service.  BBSs offer a place to post  
   messages threaded in conversations or chats. 
 
Cache  Your computer’s short-term memory that stores  
   temporarily Web files.  Clear  your cache often. 
 
Cyberspace  This was coined by William Gibson in his fantasy novel  
   Neuromancer to describe a society of the world of  
   computers. 
 
Domain  A sequence of names separated by dots or a naming  
   hierarchy. 
 
DSL   Digital Subscriber Line (DSL) uses telephone lines to  
   transmit very fast Internet information. 
 
E-mail  Electronic mail, which allows one to exchange message,  
   and attach files. 
 
FTP   File Transfer Protocol.  This is the main method of  
   transferring files over the Internet.  You can either view the  
   files or download (transfer files to your computer or to a  
   disk drive).  Due to computer viruses, it is a good idea to  
   download to your disk drive and then use an Antivirus  
   program to scan the disk before using it on your computer. 
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Home Page  All web sites begin with a Home Page that is like a table of  
   contents. 
 
Hyper Links Links text from one area to another by bolding text in a  
   different color and/or underlining specific text.  By clicking  
   your pointer on the links, it takes you to a site with related  
   information. 
 
Internet Service  Companies which have a dial-up connection to the Internet  
   usually for a Provider (ISP) fee.  Some examples are  
   American Online, EarthLink, and Uunet. 
 
Network  Groups of computers connected in a way to share files and  
   resources, such as the Internet which is a global network of  
   networks. 
 
Protocols  A formal description of message formats and rules between  
   computers to exchange the messages. 
 
Telnet  Internet standard protocol for remote terminal connection  
   service.  Allows user to interact with a remote system as if  
   the terminal were connected with the computer. 
 
URL   Refers to Uniform Resource Locator that is a WWW  
   address. 
 

 


